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Water Crisis and the Role of
Groundwater

The global water crisis is not only ongoing, but it is expected that
the water crisis will intensify as climate change accelerates.

Groundwater has different flow and storage characteristics than
surface water.

These characteristics could be well used to alleviate the water
crisis.

In this section, we will consider such a solution.
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1. Global renewable water
resources
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Total renewable water resources by country

Source:
https:/len.wikipedia.org/wiki/List_ of_ countries_ by_ to
tal_ renewable_ water_ resources

Nations with the largest estimated annual groundwater extractions (2010)

From NGWA “Facts About Global Groundwater Usage”
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MAR: Mean Annual Runoff
EWR: Environmental Water Requirements
(The environment requires a certain water volume for upkeep, and therefore not all
water (measured as MAR) can be considered available for human consumption.)

Gl = Withdrawals
" MAR — EWR

Falkenmark Indicator (FI) and Water Stress Indicator (WSI)

Falkenmark Indicator (FI) = Surface Runoff / Population

Vladimir Smakhitn’s Water Stress Indicator (WSI)

Percentage, %
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Trends and prospects of available water resources

—i— Developed coutries

—o— Developing countries of humid
climate

—i— Developing countries of arid
climate

Trends and prospects of available water resources (UNESCO)
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2. Water withdrawal and
groundwater storage

Water storage change and GRACE mission

% GRACE (Gravity Recovery and Climate
Experiment) mission to assess (ground
)water resources

% The twin satellites of GRACE can sense
tiny changes in Earth's gravity

— estimate terrestrial water storage
changes

(image from nasa.gov)
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Water storage change estimated by GRACE data (1)

Water storage change estimated by GRACE data (2)

India's groundwater losses (red) and gains (blue) between 2002 and 2008 from NASA's Scientific
Visualization Studio (svs.gsfc.nasa.gov)
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Year

Indian population and water availability

Population in Million

Per capita water availability in CM

1951

1965

1991

2001

2025

2050

361

395

846

1027

1394
(projective)

1640
(projective)

5177

4732

2209

1820

1341

1140

From Prasad (2007)

India’s groundwater problem
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NATURE NEWS

China faces up to groundwater crisis

Researchers call for effective monitoring and
management of water resources.

A crisis is developing beneath
China’s thirsty farms and cities,
but no one knows its full extent.
With about 20% of the world’s
population but only about 5-7%
of global freshwater resources,
China draws heavily on ground
water.

Groundwater is an essential source of
Irrigation for much of China’s arid land.

SCIENCE ADVANCES
Four billion people facing severe water scarcity

Abstract

Freshwater scarcity is increasingly perceived as a global systemic risk.

Previous global water scarcity assessments, measuring water scarcity annually,
Have underestimated experienced water scarcity by failing to capture the seasonal
Fluctuations in water consumption and availability. We assess blue water scarcity
Globally at a high spatial resolution and availability. We find that two-thirds of
The global population(4.0 billion people) live under conditions of svere water
Scarcity at least 1 month of the year. Nearly half of those people live in India and
China. Half a billion people in the world face severe water scarcity all year round.
Putting caps to water consumption by river basin, increasing water-use efficiencies,
And better sharing of the limited freshwater resources will be key in reducing the
Threat posed by water scarcity on biodiversity and human welfare.
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Increasing water demands in ASIA

Water problem threats Asia’s economic growth

<+ The water problem in Asia

— a threat to economic growth:

- water based industry (steel, computer chip, pa
per factories, and others, need large amounts of
water)

- intensive farming for foods needs large amounts
of fresh water resources (+ polluting water
resources)

- people living in the Asian region grow richer
(more household machines - dishwashers,
clothes-washing machines)
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Global warming effect on Tibetian snowpack?

Asia and Water Problem
: A Potential flashpoint

Map from Bulletin of the American Meteorological Society 102, 5; 10.1175/BAMS-D-20-0207.1

Global warming effect on Tibetian snowpack?

% Global warming — Melt the glaciers and snow of
the Tibetan Plateau that feed Asia's largest rivers
(Ganges, Indus, Mekong, Yangtze, Yellow)

% Glaciers:
- natural storage system.
- Shrinking ice sheets and snowpack could
aggravate water imbalances.
(causing flooding as the melting accelerates,
followed by a reduction in river flows)
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3. Water quantity and quality
problems

Global problems of water quantity and quality

N/ H .

- As of 2015, 748 million people did not have access to clean water for daily
living

- World population estimated at 9 billion in 2050, water demand in 2050 will
increase by 55% compared to present (2015)

- By 2030, water supply will only account for 60% of human needs (unless
we innovate current water use trends)

. .

- More than 2 billion people suffer from water-related diseases each year.
Of these, several million die from unsanitary water use

- In July 2010, the UN General Assembly adopted a resolution declaring
clean and sanitary water a basic human right of mankind
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‘Blue gold’ and Global water problem

Blue Gold Blue Gold
The global water
crisis and the
World commodification of
Water Wars the world's water
Supply

“Anyone who can
solve the problems of
water, “will be worthy of
two Nobel prizes-
one for peace and
one for science.”

John F. Kennedy

A documentary film
by Sam Bozzo
2008

A Special Report by the
International Forum on
Globalization (IFG) by

Maude Barlow 2001

“The wars of the next
century will be about
water”

Ismail Serageldin,
Vice President of the
World Bank

24

4. Efforts to find potentially
useful water
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Water distribution and potentially useful water

Responding to global water shortage

<+ Find Potentially useful waters and apply developed technology
- Saline water — Desalination plant

Frozen water — Lasso iceberg

Groundwater — Mining groundwater

Groundwater — Increase recharge/storage/restore quality (*)
Recycling — Water treatment

Rain — Rainwater harvesting

= Opportunity of industrial growth for technologically developed
countries

= Crisis of technologically or economically poor countries

% Countries suffering from water shortage or water quality pro
blem do not have the necessary technology or economy
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Make groundwater more useful

% We can increase the quantity and improve the quality of
groundwater

Optimized management of quantity and quality of groundwater

Artificial recharge

Subsurface dam

Smart well grid system

Groundwater quality enhancement

Long-term Trend of contamination and water quality management

% Schematic diagram of long-term changes in NO,-N and ClI

Area: Western Mid-mountainous Eastern

l |l I l |

Land use change

(Image from E. Koh)
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NO;-N Contamination in Groundwater

% How to conserve groundwater in terms of water quality?

1. Manage land use or manage fertilizer usage.

2. Detect and treat short circuits of contamination and allow more time of

natural attenuation.
[ty wer] [

| Numerical Modeling to estimate allowable loading

Estimation of maximum allowable loading for the fertilizer use

Based on the prediction results <MIN>

0.45*(@+®) = 281.6 kg-N/halyr (45% of
For lowering NO;-N Conc. at the regional —__ e ijizer 2 present fertilizer use)
GW well, pplication <MAX>
Amount of @ is required to be reduced rate (0.45* @) + @ = 407.8 kg-N/halyr (65% of
as 45% present fertilizer use )

Sealing of the leaky wells rapidly decrease the NO5;-N concentration below the
MCL without reducing fertilizer usage
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Long-term prediction by numerical Modeling
<Leaky well + Present N input> <Leaky well + N input reduction>

45% of present N input

<Sealing well+ Present N input>

(from E. Koh)

5. Global corporation for water
problems
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Blue Covenant — by Maude Barlow

“The world is running out of available, clean freshwater at an exp
onentially dangerous rate just as the population of the world is s
et to increase again. It is like a comet poised to hit the Earth”

“The fresh-water crisis is easily as great a threat to the Earth an
d humans as climate change (to which it is deeply linked) but h
as had very little attention paid to it in comparison”

International leadership for water problems

% Global Imbalance of Water Resources and Water Trade

Poor and water-poor countries export huge amounts of water
just for economic survival

(destroy their aquifers or reservoirs for exporting foods, flowers,
growing “biofuels” — sugarcane, corn, palm oil, soy)
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Global Inequality in Water Issues

Thank you very much
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Introduction to Groundwater:
Origin, Distribution, and Flow Principles

Starting from the origin of water on Earth, this chapter deals with
the global distribution of water, the definition of groundwater, the
subsurface space of groundwater, the basic principle of
groundwater flow, the potential of groundwater, and the
residence time of groundwater,

The purpose of this chapter is to establish the basic conceptual
understanding on groundwater and its flow system,
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1. Origin of Earth’ s water and its distribution

2. Definition of Groundwater and Aquifer

3. Hydrologic cycle and groundwater

4. Hydraulic head and groundwater flow

5. Groundwater basin and residence time

1. Origin of Earth’ s water and
its distribution
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Earth's Water Distribution

Though the amount of
water locked up in
groundwater is a small
percentage of all of
Earth's water,

it represents a large
percentage of total
freshwater on Earth

The Origin of Water in the Earth

New measurements of enstatite chondrites indicate that water could have been primarily
acquired from Earth's building blocks. Additional water was delivered to Earth's early
oceans and atmosphere by water-rich material from comets and the outer asteroid belt.

Asteroid belt

Proto-Earth

_ Snow line

~ Proto-Jupiter

Provenance of Earth's water " Comet

1 Enstatite chondrite-like material o
2 Carbonaceous chondrite-like material
3 Comets contributing to the atmosphere’s composition

Image from SC/ENCE +28 Aug 2020+Vol 369, Issue 6507+p. 1058

Groundwater exclusively
below the groundwater table?
How much water below the
Earth’ s surface?

About 1/2 of groundwater is
distributed to a depth of 800
meters, and about 1/2 is
distributed to more than a few
kilometers underground, but as
the depth increases, the
porosity decreases and there is
almost no groundwater,

Recent researches indicate that
Earth’ s mantle might hold
more water than all the oceans.
Exist as atoms of hydrogen and
oxygen embedded in the crystal
structure of the mineral This
hydrous mineral when it melts,
spills out water.
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Relative Amounts of Earth’'s Water

This image (from USGS)
shows blue spheres
representing relative
amounts of Earth's water
in comparison to the size
of the Earth.

About 71 percent of the
Earth's surface is water—
covered, and

the oceans hold about
96.5 percent of all Earth's
water. Water also exists in
the air as water vapor,

in rivers and lakes, in
icecaps and glaciers, in
the ground as soil
moisture and in aquifers,

2. Definition of Groundwater
and Aquifer
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Groundwater and Aquifer

What is groundwater?

Grounadwater is the subsurface water that occurs beneath the water table in
soils and geologic formations that are fully saturated (classical definition).

Unsaturated soil-moisture regime directly interact with the groundwater and the
study of groundwater must rest on an understanding of the subsurface water
regime in a broader sense.

Aquifer is best defined as a saturated permeable geologic unit that can transmit
significant quantities of water under ordinary hydraulic gradients (Freeze and
Cherry, 1919) That is a body of saturated rock or geological formation through
which water can easily move so that it contains and releases water in
appreciable amounts.

Visualization of water in subsurface soil and rocks

(image from USGS)
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Groundwater System and Recharge

Groundwater system (USGS; Winter
and others, 1998; Cohen and
others, 1968)

Groundwater that is easily
obtainable by wells occurs in
aquifers, which are water—
bearing formations capable of
yielding enough water to supply
peoples' uses.

The upper layer is the
unsaturated zone, where water is
present in varying amounts that
change over time,

Groundwater Flow Rates

Grounadwater flows underground...at different rates
(from USGS)

The direction
and speed

of groundwater
movement is
determined by
the various
characteristics of
aquifers and fluid
potential of
groundwater
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3. Hydrologic Cycle and
Groundwater

The Natural Water Cycle and Components

The Natural Water Cycle

Earth's water is always
in movement, and the
natural water cycle, also
known as the hydrologic
cycle, describes the
continuous movement of
water on, above, and
below the surface of the
Earth. Water is always
changing states
between liquid, vapor,
and ice, with these
processes happening in
the blink of an eye and
over millions of years.
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Groundwater and the Hydrologic Cycle

From Freeze and Cherry (1979)

16

4. Hydraulic Head and
Groundwater Flow
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Fluid Potential and Flow

For Water to Move
a driving force is needed
But it doesn’ t necessarily flow downhill
Nor from high p to low p

Consider a siphon

Hydraulic Head and Fluid Potential (1)

Hubbert’ s Analysis of the Fluid Potential

W1: the work required to lift the mass

- Hevatons from elevation z = 0 to elevation z = mgz
. .'/'/ﬂ/ Pressure: p
Pes Velocity: v . .
" Densitep | W2: the work required to accelerate
N Volume of unit mass: V= 2~ the fluid from velocity v =0 to
velocity v = 4+ mv2
: > W3: the work done on the fluid in
raising the fluid pressure
Arbi dard _ _ PV _ P dp
from P =Poto P =m [, Ldp=m [ =
Pressure: p = p, (atmospheric)
Velocity:v = 0
Density: p, —_
V:Izi\e of unit mass:V, = L— W - W1 + W2 + W3
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Hydraulic Head and Fluid Potential (2)

Total work done or total mechanical energy difference W = W1 + W2 + W3

Total fluid potential @ = W/m

vZ Pdp
d=gz+ —+ | —
2 p, P

Total head h = W/mg = &/m

For porous—media flow, velocities are extremely low, so the second term can
almost always be neglected.

For incompressible fluids (fluids with a constant density, so that p is not a
function of p), hydraulic head can be simplified to

h = z + v2/2g = elevation head (z) + pressure head (v2/2g)

Hydraulic Head and Fluid Potential (3)

Flow Proceeds from High to Low Head
Recall the Bernoulli Equation from Fluid Mechanics

P v2 P v?
hz_h1=<_2+Z2 +_2)_<_1+Z1+_1>
14 29 14 29

When flow is laminar, the velocity component can be neglected
Reynolds number reflects flow regime

R = Velocity xdiameter particle _ Vd __dynamic viscosity
- kinematic viscosity v fluid density

Lt
p

R { 100 laminar
R ) 1000 turbulent
Between — transitional
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Hydraulic Conductivity and Permeability (1)

PROPERTIES AND PARAMETERS THAT INFLUENCE
GROUNDWATER FLOW - continued

PERMEABILITY
The capacity of a porous medium to transmit fluid

HYDRAULIC CONUCTIVITY
When the fluid is water

The range of value spans many orders of
magnitude:
Gravel ~ 1x 10%cm/sec
Unfractured Crystalline Rock ~ 1 x 10~ *cm/sec

Darcy’ s Law and Groundwater Flow (1)

Darcy’s law obtained from experiments  We will define g, the specific
discharge through the cylinder, as

a=Q/A
If the dimensions of the Q are [L3/T]

and those of A are [L2], g has the
ATh dimensions of velocity [L/T].

The experiments carried out by
Darcy showed that q is directly
proportional to h1 — h2 when A4l is
held constant, and inversely

T proportional to A1 when h1 —h2 is
z} | } h| held constant, If we define Ah = h2
- hi,

=0 Darcy’ s law can be written as
a=-K(Ah/Al) or in differential
form
Q = —K (dh/dl)

where h is the hydraulic head, K is
the hydraulic conductivity
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Darcy’ s Law and Groundwater Flow (2)

Calculate K
Using data from
Darcy Apparatus
What measurements will you need?

What equation will you solve?

Darcy Velocity vs Interstitial Veelocity

Darcy velocity is a DISCHARGE per unit AREA

Q

VDarcy = A

Interstitial Velocity
Velocity through the pores
This governs rate of pollutant movement

A Vp

Vinterstitial =
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Hydraulic Conductivity (K)

K VALUES VARY WITHIN
SPACE AND WITH DIRECTION

HETEROGENEITY - describes spatial variation
ANISOTROPY - describes direction variation

HOMOGENEOQUS - uniform throughout
(K independent of position)

ISOTROPIC - properties do not vary with direction

Hydraulic Conductivity (K)

ANISOTROPY
CONSIDER K IN THE PRINCIPLE DIRECTIONS X,Y,Z

ISOTROPIC - Ky = Ky = Ky,
TRANSVERSELY ISOTROPIC - Ky = Ky not = K;

CONSIDER THE RELATIONS OF K IN A VERTICAL CROSS
SECTION

T 21_,1_’

3L L 41_’ N

_39_
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| Hydraulic Conductivity (K)

LAYERED HETEROGENEITY
Individual layers are homogeneous

| Hydraulic Conductivity (K)

DISCONTINUOUS HETEROGENEITY
e.d. across a fault
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Hydraulic Conductivity (K)

TRENDING HETEROGENEITY
Variation in sedimentation patterns

K1

K2
K3

Hydraulic Conductivity (K)

RANDOM HETEROGENEITY
Small scale variation with a structure that isn’ t easily tied to
geologic process, although we know it is its basis we can
describe with geostatistics (spatial statistics)

real Ink

y (m)
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Hydraulic Conductivity (K)
AVERAGING OPTIONS

Arithmetic
K1+K2+K3+"'+KN

N

Geometric
1 1
’\4/1(1]{2]{3 Ky or 10(ﬁ (log K1 tlog Ky +--+log KN)) or 1()(N log(Kle...KN))

Harmonic

Ld;
d;
X

Porosity and Storage Coefficients

PROPERTIES AND PARAMETERS THAT INFLUENCE
GROUNDWATER FLOW

PORE SPACE -
WHERE GW IS STORED AND MOVES THROUGH MATERIALS

POROSITY (TOTAL) - % OF MATERIAL THAT IS VOIDS
¢=V/Vr

I}, - VOL OF VOIDS
Vr - TOTAL VOLUME
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Porosity and Storage Coefficients

METHODS OF MEASURING POROSITY (¢ ,n)
DUDUCE from
PD - PARTICLE DENSITY
FD - FLUID DENSITY
BD - BULK DENSITY
BD = (1-) PD + ¢(FD)

OR
SW - SATURATED WEIGHT
Vr - TOTAL VOL
DW - DRY WEIGHT
SW —-Dw
¢ = 7

OR
DW - DRY WEIGHT
Vr - TOTAL VOLUME

M=PD(1—¢)

Vr
1 DwW
¢= DP % Vy

Porosity and Storage Coefficients

EFFECTIVE POROSITY - % OF ROCK THAT IS
INTERCONNECTED PORE SPACE

Viy
¢e _V_T

Viy - VOL OF INTERCONNECTED VOIDS

MEASUREMENT OF EFFECTIVE POROSITY

GRAVITY DRAINAGE @ 100% RELATIVE HUMID

TRACER TEST - MONITOR RATE OF MOVEMENT OF A TAG
ON THE WATER
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Porosity and Storage Coefficients

PRIMARY POROSITY
- FORMED CONTEMPORANEOUSLY WITH ROCK
SECONDARY POROSITY
- FORMED AFTER ROCK IS FORMED

POROSITY DEPENDS ON:

SHAPE AND ARRANGEMENT OF PARTICLES
DEGREE OF SORTING (MIX OF PARTICLE SIZES)
CEMENTATION OR COMPACTION
REMOVAL OF MATERIAL BY SOLUTION

FRACTURING AND JOINTING

Porosity and Storage Coefficients

SHAPE AND ARRANGEMENT OF PARTICLES
Magnitude of p depends on packing as well as shape

Packing - The spacing and mutual arrangement of
particles within the mass

- Will influence not only porosity but also
density, bearing capacity, strength, amt of
setting, permeability

- Difficult to study with real particles because
shapes are so varied, so consider spheres
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Porosity and Storage Coefficients

WE CAN’ T RECOVER ALL THE WATER FROM THE PORES,
SO CONSIDER HOW MUCH A MATERIAL WILL YIELD

SPECIFIC YIELD - % OF TOTAL VOLUME THAT CAN BE
DRAINED BY GRAVITY

sound familiar?

what else was defined this way?
they can be used interchangeably

SPECIFIC RETENTION - % OF TOTAL VOLUME HELD AGAINST
GRAVITY

BY DEFINITION - ¢ = SY + SR

Storage Coefficients and Groundwater Yield

Water level decline in an Unconfined Aquifer water drains from
pores which fill with air
Volume Yielded = Ah * SY * Area (see later qualification)
(plan area of surface extending “into” the drawing)
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Storage Coefficients and Groundwater Yield

Water level decline in a Confined Aquifer
water pressure decreases in pores which stay full of water
Volume Yielded = Ah * S * Area
(plan area of surface extending “into” the drawing)

§ An

Arg
¥~ a)|Shallow
aquifer

«—_Db} Deeper
aquifer

\

Where does the water come from? c) wells

Storage Coefficients and Groundwater Yield

STORATIVITY - S : unitless
Also called Storage Coefficient
VOLUME OF WATER AQUIFER RELEASES
PER UNIT SURFACE AREA
PER UNIT CHANGE IN HEAD
NORMAL TO THE SURFACE

SPECIFIC STORAGE - s or Sg: Lt
VOLUME OF WATER AQUIFER RELEASES
PER UNIT VOLUME
PER UNIT CHANGE IN HEAD
NORMAL TO THE SURFACE

For aquifer thickness = b
S=Sb s=S/b
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Storage Coefficients and Groundwater Yield1

Define -

@ - POROSITY
a - VERTICAL COMPRESSIBILITY OF AQUIFER SKELETON
B - COMPRESSIBILITY OF WATER
b - THICKNESS

IF WE
IGNORE LATERAL COMPRESSIBILITY
IGNORE COMPRESSIBILITY OF SOLID

And EXPLORE PARTS OF STORAGE TERM :

Storage Coefficients and Groundwater Yield

IF AQUIFER IS RIGID - water given up from a unit volume for a unit drop in head
would be entirely due to expansion of water

¢bBy

IF WATER IS RIGID - water given up from a unit volume for a unit drop in head
would be entirely due to compression of aquifer

bay
STORAGE COEFFICIENT
S=yb(¢pf+a)
SPECIFIC STORAGE
S¢=S/b
VOLUME
SAh A
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Storage Coefficients and Groundwater Yield

Water level decline in an Unconfined Aquifer
Because water is released from elastic storage in the zone
below the lowered water table the complete expression is :

Volume Yielded = Ah * (SY + S;h) x Area

| Storage Coefficients and Groundwater Yield

Sgh is often small and ignored,
Oris “lumped” into SY
Volume Yielded = Ah * (SY) * Area
But this can lead to significant error in, for example a clay where S;h may be
on the order of, or exceed, SY
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5. Groundwater Basin and
Residence Time

Drainage Basin and Groundwater Basin (1)

BALANCE APPLIES NOT ONLY TO THE ENTIRE EARTH, BUT ALSO TO ANY SUB -
DOMAIN OF THE HYDROLOGIC SYSTEM
e.g. Atmosphere
Ocean
Continent
Watershed
Stream Segment
Lake
Even anthropogenic objects: processing tank or a pool
Or Political entities: counties, states, nations

COMPONENTS OF A BASIN WATER BUDGET
INFLOW = OUTFLOW +/— CHANGE IN STORAGE
IN" S
PRECIPITATION + SW INFLOW + SW INFLOW + IMPORTED WATER =
ouT S
ET + EVAPORATION + SW OUT + GW OUT + EXPORT + CONSUMPTION

STORAGE
+ INCREASE IN SW STORAGE + INCREASE IN GW STORAGE
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Drainage Basin and Groundwater Basin (2)

DRAINAGE BASIN - Area Surrounded by a Topographic Divide may Differ from
GroundWater Basin

GROUNDWATER BASIN - Surrounded by Phreatic (Water Table) Divide
Water Table - Surface below which all cracks and pores in the subsurface are
full of water
Phreatic - All Water in Saturated Zone

WHEN DIVIDES DO NOT CORRESPOND - INTERBASIN FLOW
Volume[L3/T] = Precipitation[L/T] * Area = [L?]

Ground
surface

Water
table

(/777777777 777K /A 77

mpermeable
base

| Drainage Basin and Groundwater Basin (3)

Source: https://www.dkfindout.com/us/earth/rivers/how-do-rivers-form/
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Drainage Basin and Groundwater Basin (4)

Cross section from previous diagram

Ground water divide

Surface water divide

Groundwater Flow, Aquifer Residence and Age (1)

Groundwater Age (A1) :

the time interval between the time when water entered
the saturated zone (the time water entered into
groundwater) and the time when the water was
sampled at a specific location (x, vy, z)
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Groundwater Flow, Aquifer Residence and Age (2)

The concept of groundwater dating represents levels of complexity (IAEA, 2013)

Groundwater Flow, Aquifer Residence and Age (3)

Isotope and chemical tracers use for estimating groundwater age (IAEA, 2013)
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Groundwater Flow, Aquifer Residence and Age (4)

Groundwater age mixing

Modified from Winter et al,, 1998

» Groundwater age is composed of water particles with various
ages depending on aquifer structure, heterogeneity of the
physical parameters and recharge patterns (Cook & Bohlke,
2000; Cornaton, 2004; Bethke and Johnson, 2008).

Aquifer vulnerability by various

» Groundwater age mixing process > sources

53

Groundwater Flow, Aquifer Residence and Age (5)

Comparison of age estimation models

1) Lumped perameter mode! (LPM) 2) Numerical model

(Therrien et al., 2010)
(Maloszewski and Zuber, 1982; 1993)

. Applying mixing of tracers using simplified
aquifer geometry and flow characteristics

. Advection—dispersion equation for age CDF
(cumulative density function, G,)

- Decay of radioactive tracer aaiA 6 =V-6DVG, —VqGy — qoGa
Cout(t :fc- t —t") exp(—=At") g(t")dt'
out (£) L) p( )g(_) dGy(a) <€ Age PDF (probabiity
Conc.ofage 0 Age distribution functions gala) = density function)

Input conc. da

tracer

= Aquifer complexity
---- > > Age distribution?
- Nitrate timescale?
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Groundwater Recharge in Water Cycle
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The world's water saltwater: 97.5% Predicted water scarcity and stress in 2025

freshwater: 2.5%

68.9% - locked in gladers
30.8% - groundwater
0.3% - lakes and rivers

ZOURCE : UNEF B - Scarcity [ - Stress ZOURGE: UMER

® The amount of water on Earth is fixed. Less than 0.01% of the
planet's 1.4 billion cubic kilometres is easily accessible freshwater in

lakes and rivers.

® Africa and Asia are already hard-hit by water stress. Increasing
populations will create more pressure in the coming decades.

3

Healy, RW.,, Winter, T.C,, LaBaugh, JW., and Franke,
O.L, 2007, Water budgets: Foundations for effective
water-resources and environmental management:
U.S. Geological Survey Circular 1308, 90 p.

A. Fares (ed.), Emerging Issues in Groundwater Resources, Advances in
Water Security, DOI 10.1007/978-3-319-32008-3_11




Groundwater

+ Less than 6% of the
groundwater in the uppermost
portion of earth’s landmass is
modern(<50 yrs)

* The total gw volume in the
upper 2 km of continental curst
is aprox. 22.6 M km3

* 0.1-5.0 M km3 is less than 50
yrs old Groundwater 25

019

75 100 Yearsold or younger

049 063 Milionkm?

Older groundwater storage
21,97 million kim?

al ] Major regional aquites systems: L4 f

[] sias with sicemse impertant but eomples aquitess.

[:j A with boal mince agquifiers

A. Fares (ed.), Emerging Issues in Groundwater Resources, Advances
in Water Security, DOI 10.1007/978-3-319-32008-3_11

_59_
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» (Definition) cycle that involves the continuous circulation of water in the
Earth-atmosphere system

= Endless, global scale, process linking water in atmosphere, on continents,
and in oceans

Source : USGS

Processes in Hydrologic Cycle




Groundwater

*  Precipitation
— Rain
— Snow
*  Runoff
— Surface & Subsurface P
«  Evaporation /
— BEvapotranspiration
* Recharge
— Infitration i
—  percolation 0 Zangn \ i e
*  Stream flow i
— Baseflow . i ‘
* Storage N
- Glaciers
— aquifers

— Lakes, etc “

ISCHARGE

e :

« Water in atmosphere returning to Earth as liquid or solid (rain, snow, sleet)
+ Most precipitation result of evaporation over oceans
+ Extreme variability around world

Source: GPCC (Global Precipitation Climatology Centre) version 2020, 0.5 degree precipitation for July in mm/month
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Surface Runoff:

— Water flowing across land surface as streams, rivers, and drains after rain
storm or melting snow

Subsurface (Groundwater) Runoff [Qg,]:

— Water flowing beneath land surface through sediments and rock

Evaporation
— Process converting water to water vapor
+ Evapotranspiration [ET]
— Evaporation from soil surface and transpiration from plants
+ Water Storage (AS)
- Walter collected in naturally occurring or manmade bodies along hydrologic
cycle
— Storage bodies include: lakes, reservoirs, wetlands, aquifer, ice caps
+ Water Budget
— Volume of water transferred in hydrologic cycle

— Water budget developed for a hydrologic system e.g., watershed or where
water stored e.g., surface or groundwater

— Calculation involves a direct accounting for the inflows and outflows of water

1"

* Lysimeter — Container holding soil and plants

B, =S +P+1-S-D

S; = Volume of initial soil moisture
S¢ = Volume of final soil moisture
P = Precipitation

| = Irrigation water added

D = Excess moisture drained from the soil

From http://www.llansadwrn-wx.co.uk

12




Groundwater

* Precipitation
— Water in atmosphere returning to Earth as liquid or solid (rain, snow,
sleet)
— Most precipitation result of evaporation over oceans
— Extreme variability around world

« Effective depth of precipitation = Effective Uniform
Depth(EUD)

* "average” rainfall value over watershed
* Estimating EUD

— Generally uniform rain density = arithmetic average
— Non uniform rain density

* 1. Thiessen polygon method: based on a weighting factor for each rain
gage

+ 2. Isohyetal method (lines of equal rainfall): based on relative size of each
isohyets area

13

14
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15

16




Groundwater

+ Events during precipitation
* 1. Interception: 8-35% Hydrograph

+ 2. Stem flow Peak

rainfall Peak discharge

« 3. Infiltration (-> recharge)
« 4. Depression storage (puddle)
« 5. Overland flow (Runoff)

Run-off / discharge (cumecs)
Precipitation (mm)

Approach
segment
12:00 00:00 12:00 00:00
' '
Day 1 f Day 2
l Storm run-off D Normal (base) flow

https://geographyaslevelaga.wordpress.com

https://kejian1.cmatc.cn 17

+  Stream flow (Q) = avg. velocity (V) x cross sectional area (A)

In each subsection:

Area = Depth x Width

Discharge = Area x Velocity

Current-meter discharge measurements are made Propeller current meter
by determining the discharge in each subsection of a channel

cross section and summing the subsection discharges to obtain

a total discharge.

https://water.usgs.gov

18
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How to measure this in real time

+  Rating curve is a graph of discharge versus stream water level (stage) for a given point on a stream
*  Rating curve enables us to convert the water level to discharge rate in real time

Rating curve Stream water level monitoring station

https://www.utdallas.edu

19

Groundwater Recharge

Precipitation

Streamflow

Evapotranspiration & Evaporation

*Stream flow = runoff + base flow

20




Groundwater

For a given control volume (eg, watershed) in a time interval At
Input — Output = Astorage  (continity equation)

IN CPrecipitation, Surface water inflow, Groundwater inflow, Imported water j
ouT Evapotranspiration, Reservoir evaporation, Surface water outflow, Groundwater outflow, Exported water j

A Storage change in a watershed
(groundwater, surface water)

P+Qin:ET+Qnuf+AS

Written for a control volume
such as watershed or catchment

Healy, RW., Winter, T.C,, LaBaugh, JW., and Franke, O.L,

2007, Water budgets: Foundations for effective water-

resources and environmental management: U.S. Geological

Survey Circular 1308, 90 p. 21

Write a hydrologic budget equation for the scenarios below.
Calculate the change in storage.
Write whether the hydrologic budget is at a loss, a gain, or at steady state.

*  a Grounawater pumping [Qyyy.l = 10 mm/Ar
*  b. Surface water Runoff [Q,,.,z]= 96 mm/yr.
¢ Evapotranspiration [ET]= 550 mm/r.

* d. Precipitation [P]= 600 mm/yr.

* e Groundwater inflow [Q, 4,]= 80 mm/yr

22




UNESCO i-WSSM

Write hydrologic budget equations for the aquifer system before/after development.

1

Source: V.M. Ponce, 2007; USGS;
Alley et al,, 1999

Sustainability
in the context of water cycle

24




Groundwater

« Historical concems on quantity of water that could be pumped from
watershed
« Concept of ‘Safe Yield'

— "The limit to the quantity of water which can be withdrawn regularly and
permanently without dangerous depletion of the storage reserve” [Lee, 1915]

« Definition expand through the years
— Meinzer (1923): economic aspect
— Conkling (1946): conditions for safe yield
— Banks (1953): protection water rights

« ‘Safe Yield' is not a unique or constant value
— ldea good but implementation difficult

Moving from Safe Yield to Sustainability

25

» Limit groundwater use to levels that can be sustained over longer time

— ... development and use ... that can be maintained for indefinite time without
unacceptable environmental, social, economic consequences.

« ‘Sustainability’ is also ambiguous, difficult to define

« Broader than safe yield concepts
— Considers role of groundwater in streams, rivers, wetlands

26
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+  Concept of safe yield obsolete because groundwater and surface water connected

+  groundwater depletion causes depletion of surface water

A. Natural system with
groundwater discharge to stream
(Natural recharge = natural
discharge)

B. Moderate pumping causes
reduced inflow to stream
(pumping=captured recharge +
captured discharge)

C. Heavy pumping induces flow
from stream (pumping = CR+CD ¢
+ captured storage) i

Source: USGS

Source : Winter TC, Harvey JW, Franke OL, Alley
WM (1998) Ground water and surface water: a
single resource. U.S. Geological Survey Circular

z 1139:79

+  Dedines in groundwater level resulting from pumping decrease streamflow; affecting aquatic ecosystems.
+  Pumping when environmentally critical streamflows will no longer be sustained.

Source: de Graaf, I.E.M., Gleeson, T., (Rens) van Beek, L.P.H. et al. Environmental flow limits to global
groundwater pumping. Nature 574, 90-94 (2019). https://doi.org/10.1038/s41586-019-1594-4




Groundwater

been, or will be, reached

Source: de Graaf, |.E.M., Gleeson, T., (Rens) van Beek,
L.P.H. et al. Environmental flow limits to global
groundwater pumping. Nature 574, 90-94 (2019).
https://doi.org/10.1038/s41586-019-1594-4

The first time at which environmental flow limits have

Gridded estimates of cumulative
groundwater water depletion

(in m3 per m2) for 1960-2099

29

Cumulative groundwater depletion (kn?) in historic and model simulation
a 12500

Source: de Graaf, .E.M., Gleeson, T.,
(Rens) van Beek, L.P.H. et al.
PN e Environmental flow limits to global
¢ groundwater pumping. Nature 574,
7 90-94 (2019).
https://doi.org/10.1038/s41586-019-
1594-4
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“the frog in the pot”
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30 management-stefan-trappitsch




UNESCO i-WSSM

Thank you very much
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Groundwater

Managed Aquifer Recharge (MAR)
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Atmosphere  Vegetation  Surfacewater  Soil water
12,000km* 1,000 km? 00 km?), 16,000 km®
<
Modern groundwater
347780 km?

* The total GW volume in the
upper 2 km of continental curst
is approx. 22.6 M km3

*  Modern GW (younger than 50
yrs old) volume is 0.35 M km?
(1.6%)

* Volume of Modern GW is much
larger than those of surface Groundwater 25
water, soil water, water in 019
atmosphere and vegetation. :

75 100 Yearsold or younger
049 063 Million km? :
< =

Older groundwater storage
21.97 million km?®

(Source: Kim, 2007) N % ) o .

. 5 * High variation in annual

k K mean rainfall compared to
other countries

+ Necessity of seasonal

. ALY
storage due to high S
seasonal variation in LN

PPT

(Source: Dillon, 2011)
4




Groundwater

Combinations of different types of sources, methods, and purposes

Desalinized

Spreading Rainwater
basin, SAT Harvesting

+ Underground Dam for Agri, Domestic or Drinking Water

*  River Bank Fittration for Drinking Water

«  ASTR-type MAR in Volcanic Island Aquifer

+  Rainwater Harvesting from Greenhouse Roof

+  MAR for sustainability in Shallow Geothermal Greenhouse Field
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*  Subsurface (underground) dam
. buit entirely underground into sandy riverbeds of seasonal water courses and founded on impermesable bedrock to intercept groundwater flow

«  Sand dam
. larger than subsurface dams and weirs as they can be raised to several meters above ground in sandy riverbeds

+  Percolation dam
. do not block ground water flow as the previous systems.
. They serve three purposes (g) to reduce the speed of surface flow; (b) inarease percolation for the recharge of shallow aqifers; and (c) obostruct the flow of sediments.

Source: https://www.geo.fu-berlin.de
Image credit: Mekdaschi & Liniger (2013)

underground dam constructed in Miyakojima, Okinawa Prefecture

-
-
-
-
-
-
-
-
~-—a
-~—o

Source: Wikipedia.org
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Location Purposes Watershed Capacity Cut-off Administr Year
area(km?) (m3/d) wall ation
length (m)
l-an (Sangju, KB) Agricultural 213 24,000 230 KRC 1983
Namsong( Yungil, KB) Agricultural 153.0 27,000 89 KRC 1986
Okseong (Kongju, CN) Agricultural 275.0 27,900 482 KRC 1986
Gocheon (Jeongeup, JB) Agricultural 27.0 25110 192 KRC 1986
U-il (Jeongeup, JB) Agricultural 22.0 16,200 778 KRC 1986
Ssangcheon (Sokcho, GW) Domestic 65.3 43,000 800 KRC 2000

- Provinces (KB: Kyungbuk; CN: Chungnam; JB: Jeonbuk; GW: Gangwon)
- KRC: Korea Rural Community Corporation

(Source: KRC, 2006)

10
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Location of Underground Dams in Korea

¢¢¢¢

(MIST,2004)

Ssangcheon Underground Dam

- Securing domestic water
- Preventing SWI

Cut-off wall

/

Collector well

(Modifed from KRC, 1999 ; Kim, 2006)
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Recent plan for underground dam

5 ® Preliminary candidates
~~~~~ / « 472 sites (Grey circle)

® Intense candidates
« 70 sites (blue circle)
» Selection based on field examination

S’

® Priority sites for comprehensive
investigation
+ 3 sites (red triagle)
+ Hongseong, ChoongNam PV
+ Goseong, Gangwon PV

+ Jindo, Jeonnam PV
() + Selection criteria
*  High drought frequency

« Low supply/demand ratio

«  No alternative methods such as
surface water supply system

* And others

(Source(personal contact)
Seong-Ho Song,2018)
13

*  Basic investigation (Jul. 2011- Dec. 2012) : final10 sites
*+  Feasibility investigation (May-Dec. 2013) : 4 priority sites
+  Basic and construction design (may-Dec. 2014) 2 sites (Anma island, Daejjak island)

Water resource status/

Sea water intrusion Basic Investigation Intense Investigation

Checking bottom-up

needs Site evaluatn

72 districts at 64 candidates
coastalfisland 15 intense
investigate site
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* 4 Priority sites (Group A)

Location Demands by  Watershed Supply/ Cut-off wall length/ No. of Intake
2025 (m3/d) area (km?)  Capacity (m3/d) method depth (m) Wells
1. Daeijak-do -109 0.35 110/180 Open cut 80/11.3 3
2. Gaeya-do -129 130 Inj. Well (3-line) 271123 5
3. Anma-do -93 147 100 Inj. Well (3-line) 480/31 6
4. Cheongsan-do -323 330 Inj. Well (3-line) 400/ 25 10
1 2 3 4
J I::: | I I

{

||l

u

&
[
g b
[
s 3

15

1. Daeijak-do

Cut-off wall
L=60m

3 Intake wells
Q=60m?/d/well

16




Groundwater

3. Anma-do

Cut-off wall
L=460m

Radial Collector well
L=120m, 10 wells

Desalinization plant
150 m3d

17

A technology that operates
by pumping out water from boreholes
drilled along the banks of a river or lake

Mauro & Utari, 2011 (Water Practice and Technology (2011) 6 (4): wpt20110073.)

PARTINOUDI, VASILIKI & Collins, Michael. (2007)
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18 sites (as of 2016)

— Radial : vertical : others = 12 (67%) : 4 (22%) : 2
Total facility capacity: 1,106,210 m?/d

— Radial : vertical : others = 926 (84%) : 110 (10%) : 70
Pumping capacity per well (m?/d)

— Radial (16,500), vertical (1,400)
Purposes

— Wiater works(7), agriculture(5), stream discharge(3), others (2)
Watershed

— Han-river (5 sites, 188,000m?3/d)

— Nakdong-river (6 sites, 709,000 m?3/d)

19

« First RBF : domestic water supply for a military base from Han-river
bank at Seoul in 1970’
— 20 Vertical wells / 10,000 m3/d
Largest fadiity:
- 351,000 (Changneung-Jeungsan phase 1)
Most active MAR method in Korea

Source: https:/fcnews.co kriuhtmliread jsp?idxno=2011122711074252104408section=S IN10
20




Groundwater

+ Spring and rainwater dependent
island
« Water delivering jar, "Mulheobuk”

+ Now, water supply from GW is 100%

+ But, demand gradually increases due
to migration and tourism

« therefore, securing more water
resources for the future is needed

« Site specific method for Jeju island

- Highly permeable layers in unsaturated zone
- Large unsaturated zone thickness
- Coupling with flood mitigation reservoir
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Han-Stream
Reservoir

®pilot site

- Reservoirs : ~ 900,000 m3

- Injection wells : 20
(9@450mm, depth : 40-50m) Han-Strea

- Recharge capacity per well Reservoir 2
: 3,000 m*/hr

- Recharge plan
:>3.0 M m¥/yr

23

50000 5 year
0

50000 ~ } 4
A year

40000

year

2.1 km

Head Diff.(m) 2

year

ear
70 y

60

50

40

- MODPATH Package
- GW velocity : 1,538m/yr
- ROI: 2.1 km

- Residence time in aquifer:
more than 5 years

30

20

24




Groundwater

- In 2010, total 2,500,000 m3? of water had been injected through
bottom infiltration.

— Through reservoir bottom infiltration, the flood mitigation
reservoir can be increased its capacity up to 300,000 m3/day
(33% of reservoir capacity increase) without further
construction.

25

Since 2004
Fadilities: 176
Recharge amount : 1,276,000 m’ in 2011

Green House

Monitoring Injection
Well Well -

Manhole

Rainwater pipeline

Groundwater Level D

. ®400,1=80m  _ _ ®300,L=5lm _

Photo by Kiwon Koh

26
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+ Recharge through infiltration
gallery btw greenhouses

+ Pilot research

+ Recharge amount : 28% of
rainfall

27

*  Water curtain insulated greenhouse complex *+  Losing stream by groundwater level dediine

24
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Groundwater

|17 Pumping only :I<— Pﬂ:}g{}gn& —Pl
m—m===========> Rising water level
;4.2 -> 3.6 m BGL
'f‘ Increase in min. level
:8.5->6.3 mBGL
29

Groundwater Replenishment System, California, USA

Drinking Water Wells

Huntingtan
Beach

o

Bolivar ASR systems, Australia
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In confined conditions, artificial recharge has in
general to be achieved using infiltration wells a
s the potentiometric groundwater surface is ab
ove the confining layer

Australian guidelines for Water recycling, 24:
Managed Aquifer Recharge (2009)

As the effluent moves through the soil and
the aquifer, it can undergo significant qual
ity improvements through physical, chemi
cal and biological processes - Attenuati
on

The water is stored in the underlying unco
nfined aquifer generally for subsequent re
use, such as irrigation. This is a valuable
water resources management method in a
reas with high evaporation rates.

*  [fPointof Complianceis at the extraction point




Groundwater

TS
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Nitrate reduction
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Site-SpeCifiC MAR methods based on their hydro-geo-meteorological properties

+  Aquifer recharge of surplus desalinized water with renewable solar energy
+  Challenge but chance for get sustainable Energy-Water Nexus

+  Liwa ASR system, Abu Dhabi
- Store the surplus desalinized water in oasis aquifer and
— Supply in times of emergency
—  Pipe line = 130km
—  First phase (to be completed by 2012)
7 million imperial gallons a day — injection rate
40 milion imperial gallons a day — recovery rate
- Second phase
10 million imperial gallons a day- injection rate
100 million imperial gallons a day- recovery rate

+ Various MAR schemes has been known as
promising climate-adapting methods to
secure additional water resources.

+  Korea has experiences on various MAR
methods to augment groundwater
resources such as underground dam, RBF,
rainwater harvesting and ASTR/ARR-MAR.

« MAR is one of the important key words in
water security issues all over the world,
especially in arid/semi-arid area and even in
wet area with high seasonal variation.
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Thank you very much
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Groundwater

Hydraulic Properties and Parameters of Aquifer

* Aquiclude (confining unit, confining bed)
a water-bearing layer of rock or sediment that is incapable of transmitting water
«  Aquifer
a water-bearing layer of rock or sediment that is capable of transmitting significant quantities of water
+  Aquitard (confining unit, confining bed)
a water-bearing layer of rock or sediment that transmits small quantities of water in relation to aquifer
+ Confined aquifer (artesian well)

* Unconfined aquifer (water table well)
« Perched aquifer (perched water table well)

Perched
water table Water table  aiogian
well well well

perched aquifer

Unconfined
aquifer
Confined
aquifer
2
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+  Confined aquifer: an aquifer whose upper and lower boundaries are defined by aquicludes.

* Drawdown: the amount of water level decline in a well due to pumping. Usually measured relative to
static level

*  Unconfined aquifer: an aquifer in which the water table forms the upper boundary

«  Potentiometric surface: animaginary surface to which water would rise in wells from a given point in
confined aquifer. The water table is a particular potentiometric surface for unconfined aquifers.

Potentiometric
surface

perched aquifer

Water
table
Unconfined
aquifer
Confined
aquifer
2]

® Potential energy driving groundwater movement normalized by specific
gravity

<—— —  Water table

h=z+¢

Source: Maureen Feineman, Pennsylvania State University

Water table : where pore water pressure is equal to atmospheric pressure
- above water table : unsaturated or partially saturated zone (negative
pressure)
- below water table : saturated zone (positive pressure)
- capillary fringe : area immediately above water table
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« A measure of the ability of a substance (usually soil) to transmit
water
« Hydraulic conductivity is a function of fluid and media

K : hydraulic conductivity (L/T)
P ¢ fluid density
g gravitagion.al acceleration
q : dynamic viscosity (M/LT)
: mean grain diameter (L)
N : dimensionless factor depending on the shape of pore spac

Permeability

« Q~d? (grain diameter)

« Q~vy (fluid specific weight)

« Q~1/p (fluid viscosity)

« Q= (Cd?yA/p) (dh/dl)

« k=Cd?> (intrinsic permeability, C=shape factor of grain)
* Intrinsic permeability is a function of only media

e Conventional Values of Hydraulic Conductivity

Table 5.1. Ranges of hydraulic conductivities

Unconsolidated deposits Hydmulit{: "iu;sl;ductivity Rocks Hydmulit{: rﬁl;ductivity
Dense clay 107 10% Dense sandstone 10% 107
Weathered clay 10% . 10°¢ Karstic sandstone 107 10°%
Silt 107 .....10° Dense limestone 10°.....107
Alluvial deposits 104 ...10% Karstic limestone 104 ...10%
Fine sand 10% . 10 Dolomite [ 10
Medium sand sx10% . 5107 Dense crystalline rocks 101 1072
Coarse sand 104 107 Fractured crystalline rocks 10 ..10°
Fine gravel 107 .. 5x10 Dense basalt 101 1070
Medium gravel 5x10% 107 Fractured basalt 107 .10
Coarse gravel 107 . 510 Claystone 10" 10

http://echo2.epfl.ch/VICAIRE/mod_3/chapt_5/main.htm
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® Basic Theorem in Groundwater Physics :
Volumetric flow rate is proportional to the difference of hydraulic heads, cross-

sectional area and reciprocal of length

Q : Volumetric Flow Rate[*/T )
A': Cross-sectional Area {°

K : Hydraulic Conductivity (L/T)
L : Length of Column (L)

h : Hydraulic Head (L)

Henry Darcy (1856)
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« T=bK [2]
- b= saturated aquifer thidness
+  Transmissivity can be defined as the amount of v ontally through a unit width under unit
hydraulic gradient

* Aquifer : ability to “conduct” water and ability to hold water
* Porosity :

- The ratio of void space to the total volume of medium(soil and/or rock
mass)

N= Vy/Vy x 100

* Effective Porosity :

- Fraction of interconnected pore space

- Much more important to the fluid flow
Porosity of well rounded material = 26~ Relationship Between Packing and Porosity

€500 (ﬁv )
CHOOIRE 0O

-re
Cubic Packing Rhombohedral Packing
(48% Porosity) (26% Porosity)
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* Dependent on sorting : well-sorted, smaller porosity
* Can use grain size distribution to classify sediments, which can be used to
estimate porosity

The relation between grain size, porosity, specific yield and specific retention (Davis & Dewiest, 1966)

“7

Hydraulic conductivity

.
o
.
.

12
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* The volume of water which will drain under gravity from a unit volume of
aquifer

* Sy = volume of water drained by gravity / total volume of rock

+ Cannot release water when gravity force = surface tension (called nendular

water) W o
. . . . t =L
* Porosity can be the same, Sy is smaller for finer material (large ! 4
. .. . ~
* n(porosity) = Sy + Sr (Specific re.t(gnuo.n)1 YR y
e Conventional values of specific yield I
"\\"f
Rock Specific Yield (%)
Clay 1-10
Sand 10-30
Gravel 15-30
Sand and Gravel 15-25
Sandstone 5-15
Shale 05-5

+ Storage coefficient (or storativity) (S) : volume of water absorbed or
expelled per unit surface area per unit change in head
[dimensionless]

+ Specific storage (S¢) : The volume of absorbed or expelled per unit
volume per unit change in head [1/L)

v function of compressibility of fluid and medium

+ S=bSg for confined aquifer

S=S,+h§; =§, for unconfined aquifer

Source: http://www.connectedwaters.unsw.edu.au
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+  Homogeneous = same properties at all locations
- heterogeneous

*  Isotropic = same conductivity in all directions
—  anisotropic

Homogeneous, Isotropic Homogeneous, Anisotropic

Heterogeneous, Isotropic Heterogeneous, Anisotropic

335 | Groundwater flow occur
* toward down-gradient direction
* perpendicular to equipotential line

30.5
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* Fluxes are controlled by advection and hydrodynamic dispersion

* Loss or gain by chemical/biological reaction or radioactive decay

Advection (convection):
- Mass transport due to the flow of water in which the mass is carried
- The direction and rate of transport coincide with that of the groundwater flow

Hydrodynamic dispersion (spreading) : mechanical dispersion+molecular diffusion
1. Mechanical dispersion (mechanical mixing during advection)
- apparent diffusion by the complexity of flow path through the porous or fractured media
2. Molecular diffusion due to thermal-kinetic energy of solute particles

Path difference Velocity differeqce within same channel
7

Dye Tracer Transport in Bench-Scale Sand Tank #1
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 Hydrodynamic dispersion coefficient (D) : is a combination of mechanical
dispersion (D,) and molecular diffusion(Dy) [L2/T]
v The advective flow velocity (v) and mean grain diameter (d,.) is the
main factors
v" Longitudinal /Transverse dispersion

« Dispersivity(a,) : a scale dependent property of an aquier that determines
the degree to which a dissolved constituent will spread in flowing
groundwater [L]

v D, = qa_-v forlongitudinal dispersion

+ Scale dependency in the dispersion
v" Microscopic scale dispersivities as a result
of velocity changes on the pore scale are
about two orders of magnitude smaller
than macroscopic dispersivities arising from
heterogeneity in hydraulic conductivity.

Thank you very much




Groundwater Flow and Solute Transport
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Groundwater







Groundwater

Groundwater Flow and Solute Transport
Equations

In this chapter, steady-state and transient differential equations
of groundwater flow are derived using Darcy's equation, which
expresses the flow rate of groundwater flow.

Using the velocity of groundwater, transport equations
representing how contaminants or solutes in groundwater move.

A simple modification of the basic transport equation is to be
discussed when there is a sorption reaction.
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1. Groundwater flow equations

2.Contaminant/solute transport equations

1. Groundwater flow equations
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Assumptions

* Soil is saturated
— We could derive the equations to describe unsaturated flow but we

will stick to saturated flow in the class.

* Darcy s law is valid

* Mass is conserved
— i.e. , What goes in must come out or be stored based on

conservation of mass.

Steady State Saturated Flow

Inflow - outflow = 0

Mass flow rate = pv

(pvy);
D = * 3(pv)
(pvx)out = (pvx)in + ax

7o

dx
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Steady State Saturated Flow

0

(inflow — outflow), = [(pvx)in — (pvy) i — (gzx) dx|dydz = (p %) dxdydz
d(pv d(pv

(inflow — outflow), = [(pvy)in —(pvy)in — (gyy ) dy] dxdz = —(g;yy)dxdydz
d

(inflow — outflow), = !(pvz)in — (pv)in — (p:Z) dz|dxdy = (g ’z) dxdydz

Steady State Saturated Flow

(inflow — outflow)¢ora
= (inflow — outflow), +(inflow — outflow), +(inflow — outflow),= 0

a(pvx) (P'Uy) d(pvy)
Fm dxdydz — 3 dxdydz — ppe dxdydz =0
d a(pv d(pv
_0(pvy) 0(pvy) 0(pvy) dxdydz = 0

0x dy dy

a(pvx) 0 (,DUy) d(pvy)
0x dy 0z

=0
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Concentration Units

Assume that the fluid density is constant

Ovx vy Oz _
ox dy 0z

Use Darcy’ s law to express velocity

.
v k. ke k.1/0%
x xx Xy Xz oh
Uyl =—kyx Kyy kyz||o-
vy ko d. ko |7
zx zy 2zl oh
(52
Wy _O0f_p O O a_h]__ ’h _, 0*h _, 9%h
ax  ox XX 9x XY oy XZgz] = XX gx2 XY oxoy X% 9xoz
| Concentration Units
Substituting vy , vy, and v, :
L 62h+k 0%h ‘i d%h
ox2 Y oxdy 7 0xoz
0%h 0%h 0%h

Hopn gtk 3+ kg o

0%h 0%h 0%h

+kzx% + kzy _azay + kzzﬁ =0
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Concentration Units

Combining terms:

0%h d%h 0%h
kxxﬁ + kyya_:yz + kzzﬁ
d%h d%h d%h

t2ksy dxdy + 2k, 9xdz7 2kys dyoz

=0

If x, y, and z correspond to principle axes of permeability:

d%h 0%h 0%h

kxxﬁ'l'k}’YG_yz'l'kzzﬁ:

0

Concentration Units

More commonly written as:

0%h 0%h 0%h

kxm‘Fkyayz +kz 6Z2 =

it ky = ky = ky:

0*h  9%h  0%h _

dx2 t 92 + 972 0 “Laplace Equation”

Note:
1) The solution is independent of K

2) The solution is a function describing h in terms of x, y, and
z — h(x, vy, 2
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Transient Saturated Flow

, Astorage )
inflow — out flow = v + source, sink

Assume that we have no sources and sinks,
The term:

Astorage
At

Represents the change in mass stored in the system

Transient Saturated Flow

The mass per unit volume can be expressed as the density times the
volume of the voids:

m = pV, = p(n Vo) = pndxdydz

The change in storage with respect to time can then be represented as:

d(pn)
ot

dxdydz
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Transient Saturated Flow

The law of conservation of mass for transient flow requires that the net rate
at which fluid enters a control volume is equal to the time rate of change of
fluid mass storage within the control volume,

net rate of inflow = inflow — outflow = rate of change in storage ------ (A1)

From equation mentioned previously we can write

d(pvy) 0(pvy)  0(pv,)

net rate of inflow = — i 3y e

In steady-state flow, the change in storage within the control volume is zero.
In transient flow, the change in storage is not zero and equation.
So [A.2] becomes:

) _d(ew) _aGem,) _ 3(em)

0x ady 0z ot
< > +—>
Net rate of inflow Rate of change in storage

Transient Saturated Flow

Where n is the porosity of the porous mediA. The dimensions of the term % are

M/L3T or the time rate of change of fluid mass per unit volume of the control volume.
Now assume that the porous media is saturated, Then using the chain-rule we can
expand the right-hand side of equation [A.3] .

d 0 oh
ot (pn) = h (pn) % [A4]

Where we can see that, in transient, saturated flow, the rate of change in fluid
storage in the control volume is related to the rate of change in hydraulic head.
Using the product rule we can expand the first term on the right-hand side of
equation [A.4] .

on ap

— = [AS5]
Pont™an

0

% (pn) =
The first term on the right-hand side of equation [A.5] is the mass of water produced
by the expansion or compression of the porous media and the second term is the
mass of water produce by expansion or compression of the fluid, In the case of
saturated flow, water can only enter the control volume if the porosity increases

(Z—Z > 0) or the fluid density
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| Transient Saturated Flow

Increase (% > O).

To continue we must define two new terms: the porous media compressibility « and
the fluid compressibility # . Compression or expansion of the porous media is
caused by a change in effective stress o.. If the porous media is saturated

do, =—pgdy [A.6]
0
Where 1 is the pressure head. But since dy = d(h —z*) = dh — gf we can write
do, = —pgdh e %)
Now define the porous media compressibility
QA== — [A.8]
V do, do,

Where V; is the volume of fluid and V is control volume, Combining equation [A.7]

and [A.8] we have
dn
—=apg 9
1= oY [A9]

Transient Saturated Flow

The fluid compressibility B is defined as
B vy 1
- Vf o T [A.10]

Where p is the fluid pressure. The change in pressure is given by
dp = pgdy = pgdh [a11]

And with dV/V; = dp/p equation [A.10] becomes
dp 1 dp

_ r K 20 [A.12], [A.13]
B o ogdh O dh p-gp
Substituting equation [A.9] and [A.13] in to equation [A.4] gives
GO LY. ey -
gt P =\ Pty )5 = Pr9atneaB) 5
Now define the specific storage S as
Ss=pgla+np) [A.15]
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Transient Saturated Flow

The dimensions of Ss are L' representing the volume of water that a unit volume of
aquifer releases from storage for a unit decline in hydraulic head. Substituting
equation [A.15] into equation [A.14] gives

dh

0
a (pn) = pS; E

And substituting equation [A.16] into equation [A.3] we have
doh

9 9 9
—_— - R — —_— e [A.17]
o (Pv:) =3 5 (ovy) =5~ (pv2) = pSs o

If we assume that density is constant in the three coordinate directions equation

[A.17] becomes
dvy dv, 0Jv, oh
__x_y_“7Z)|_ = [A.18]

p( ox oy 0z) PP

Canceling o from both sides of equation [A.18] and using Darcy’ s Law we arrive
at the transient, saturated-flow equation,

akah+akah+ak6h—50h ...... [A19]
ax\ *ox) oay\' Yay) dz\ Zoz) “Fot

Transient Saturated Flow

If the porous media is homogeneous, k,, ky, and k, are constant and equation [A.19]
reduces to

d%h 0%h d%h oh

xﬁ-l_kya_yz-l_ 267— SE

If the porous media is also isotropic, k. = k, = k, = k, equation [A.20] is written
dh 9*h 9*h S 0h

PP Rl P T

Which is known to mathematicians as the diffusion equation. For the special case of
horizontal, two-dimensional groundwater flow in a confined aquifer of constant
thickness b equation [A.21] simplifies to

0°h  9*h  Soh

ozt dy? Tot
Where S = S;b and T = kb.

S is storativity and T is transmissivity
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Transient Saturated Flow

For 2D flow parallel to the formation:
X 62h+62h+02h _ 0Oh
9x2 " ay2 T 92| T Pt

(0%h  9%h] oh
=sbh—

S P ]

‘aZh+ 9%h] _ ;O
0x2 " ayz| "ot

For steady flow:
0%h N 0%h
d0x?  0y?

Transient Saturated Flow

For unconfined flow (nonlinear)

Boussinesq equation simplifies by taking the head drop over horizontal distance
rather than the path length, and average thickness, h:

0*h 9%h 0%h] _ o
ax2 Tay2 92| T P

] hah +a hah +a hah _Sy0h
ax\ ox/) ay\ ady) az\ 9z) K ot
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Transient Saturated Flow
For unconfined flow (nonlinear)
head drop over x rather than the path length, L (also know as Dupuit Assumptions):
Kh dh dl
q=—Kh—
dx dh
qdx = —Khdh dx
L R,
f qdx=—-K | hdh
0 hy
|L Khz hy * A
qx| =-K—
0 2 hy h, h h,
) ) | l /dy Tunit
h2 hl < >
gL = —K{— ==~ Xq L X,
| Transient Saturated Flow
If we do the same for confined flow(linear)
b dh
q=—Kb—
dx dl
dh
L hy
j qdx =—Kb | dh dx
0 hy
L hy Q =KiA
q x| =—Kbh
0 hy
qL = —Kb(hy — hy) |
h, h,
h, —h dy 1unit
q = —Kb=—— ! -
L Xi L X,
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Source and Sinks

If we have sources or sinks we can simply add one more term, R, which is
intrinsically positive and represents inflow to the system.

k 62h+k 62h+k 62h+R—S oh
Yox2 Yoayr  Fozz T ot

or
0%h d%h d%h oh

DALy S
w2 Ty gt kg =S

For outflow, R = -W where W is the withdrawal rate, R can represent:

Injection wells
Extraction wells
Rainfall
Evaporation

o~

2. Contaminant/solute transport
equations
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Contaminant / Solute Transport

Process of solute movement complex

Diffusion
moving from higher

to lower concentrations .
Advection

solute moves
with groundwater

Dispersion
Dilution and spreading

Advection

Contaminants traveling at same velocity as the groundwater
(Dissolved in the groundwater)

K dh
x n, dl

V, = average linear velocity
K = hydraulic conductivity
n, = effective porosity
dh/dl = hydraulic gradient
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Diffusion

A solute in water will move from an area of greater concentration toward an
area where it is less

Fick’ s Law (diffusion of solute through water)

dc
F = _Dda

F = mass flux of solute per unit
area per unit time

D, = diffusion coefficient

C = concentration

dC/dx= concentration gradient

Negative sign — movement from higher to lower concentration

Diffusion

In porous medium, diffusion not as effective as in open water

Tortuosity: actual length of flow path (Le) divided by straight line distance (L)
Tortuosity = Le/L

‘... .
,0. L

Solute only moves through pores

D* = effective diffusion coefficient
D* = (UDd

w = empirical coefficient
Function of the tortuosity, always {1
For non sorbed species, w = 0.01 ~ 0.5

- 123 -
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Diffusion

A solute in water will move from an area of greater concentration toward an
area where it is less

Fick’ s Law (diffusion of solute through water)

F = _Dda

F = mass flux of solute per unit
area per unit time

D, = diffusion coefficient

C = concentration

dC/dx= concentration gradient

Negative sign — movement from higher to lower concentration

Dispersion

Mechanical dispersion — caused by motion of the fluid

Flow —

Direction

Longitudinal dispersion — along the streamline

Transverse dispersion — perpendicular to flow path

- 124 -
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Dispersion , Hydrodynamic Dispersion

Dispersion
Coeff, Of Longitudinal Mechanical Dispersion = o, v,
o, = longitudinal dispersivity
Coeff, Of Transverse Mechanical Dispersion = oiv,
o = transverse dispersivity
Hydrodynamic Dispersion
Processes of diffusion and dispersion can’ t be separated out

D, = coeff. of longitudinal hydrodynamic dispersion

D, = v, + D*
D; = coeff, of transverse hydrodynamic dispersion
D; = ayv, + D*

Derivation of Advection Dispersion Equation

Solute transport is governed by laws of physics

Consider an Representative Elementary Volume
Mass flow in

Homogeneous, isotropic saturated porous medium

Darcy’ s Law applies
Control volume
Law of Mass Conservation

. . Mass flow out
Mass is neither created or destroyed

Any change in mass flowing into the small volume of the aquifer must be
balanced by the corresponding change in mass flux out of the volume or a
change in the mass stored in the volume or both
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Derivation of Advection Dispersion Equation

Let' s consider an REV ---

Solute will be transported by two processes:

1) Advection 2) hydrodynamic dispersion

Derivation of Advection Dispersion Equation

v = velocity

n.= effective porosity

C = concentration

D = hydrodynamic dispersion coeff,

Advective transport in x direction = v,n,C (dydz)

Dispersive transport in x direction = n,D,, (dC/dx) (dydz)
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Derivation of Advection Dispersion Equation

Total mass of solute in the x direction
Total mass = v,n,C(dydz) — n.D,(dC/dx)(dydz)

E, = vn,C — n,D,(dC/dx)

F,=mass flux per unit area per unit time

Total amount of solute entering REV is:
Fdydz + E,dxdz + F,dxdy
Total amount of solute leaving REV is:

o,

E+ 2% a0 ayaz + (B, + 22 ay ) axdz + [ F, + 2
X axxyz y ayyxz Z

zZ
e dz) dxdz

| Conservation of mass

The conservation of mass requires that the change in mass stored in a
control volume over time (t) equal the difference between the mass that
enters the control volume and that which exits the control volume over this
same time increment,
change in mass in control volume = mass flux in —mass flux out
mass flux in

= Fdzdy + F,dxdz + F,dxdy

mass flux out

= F+aF"d dd+F+aFyd dd+F+and dxd
—xaxxyzyayyxZZaszz

an+aFy+ag dxdyd
ax " ay oz )M
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Conservation of mass

change in mass in control volume = mass flux in —mass flux out

dz

dy

dx

Volume of control volume = dxdydz
Volume of water in control volume = (n.)dxdydz

Mass of contaminant in control volume = (C)(n)dxdydz

aM—aC dxdyd

Conservation of mass

change in mass in control volume = mass flux in — mass flux out

oF, OF, OF,

d ;
R [(C)(np)dxdydz] = — (a + Ty + 5) dxdydz

Divide both sides by the volume

0 v (O, OF, OF,
&[( )(ne)]——<a+g+5>

Substitute in expression for F

E, = v,n,C — n,D,(dC/dx)
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Conservation of mass

0  OF, 0F,
€)@ = S TR

E. = v,n,C — n,D,(dC/dx)
E, = vyn,C — n,D,(dC/dy)

E, = v,n,C — n,D,(dC/dz)

ac _ aDac+aDac+aDac
ot |ox\ *ox) oay\ Yay) o0dz\ ‘oz

0 i) 0
_ [& (v,C) + % (v,C) + 5 (vZC)]

Equation for Mass Transport for a Conservative Solute

3 Di : ac d ac 6 aCc 6 ac
imensional — = |—(D.— D. — —( D, —
ot |ox\ *ox ay Y oy T35\ 3z

0
— [a(vxC)+ (vyC)+ (vZC)]

oC d%C a%C aC

2 Dimensional
—=D—+Dr——v,—
ot~ Loxz T UTayz T Vi gy

aC d:C aC

1 Dimensional
— =D — -y, —
ot~ “loaxz  Fox
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Hydrodynamic Dispersion

_ VJ% V}Z’ 7722 * _ _ UxVy
Dxx_aLm+aTHm+aTVm+D Dyy = Dyy = (a;, — ary) o]
v5 vZ vz . VD
Dy, =aLm+aTHﬁ+aTVﬁ+D Dy, = Dy = (a, — ary) f;lz
v2 v} v5 . Vyvy
D,, = aLﬁ-l'aTHﬁ-}'aTVm'*'D Dy, =D,y = (a;, — ary) o]
a, longitudinal dispersivity
Ary, ATy transverse dispersivity
D* effective molecular diffusion coefficient
Uy, Vy, Uy components of the velocity vector

1 . .
lv| = (v,? + ng + vZZ)z magnitude of the velocity vector

Solute Transport

Conservative and Reactive Solute
Conservative
Do not react with soil / groundwater
Reactive

Sorbed on to mineral grains
As well as organic matter

If solute is reactive,
it will travel slower than groundwater rate due to adsorption
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Solute Transport

Direct linear relationship between amount of solute
Sorbed onto solid (€*) and the concentration of the solute (C)

C*=K,C
C* = mass of solute sorbed per dry unit weight of solid (mg/kg)

C = concentration of solute in solution in equilibrium with
the mass of solute sorbed onto the solid (mg/L)

K, = distribution coef ficient (L/kg)

¢ Slope of linear isotherm = Ky

Solute Transport

One dimension advection — dispersion with sorption

ac _ d*C  ac ByaC*
_=DL__vx___
ot dx? ox 0 ot

Substitute into advection — dispersion equation

oc _ 9*C  9C B,oC*

=D — . —
ot Laxz Yox 8 ot
€\, Ba, 0%
gt Lt g k) =Dz —ng

B
(1 + Fdl(d) = 17 = retardation factor
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Thank you very much
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Well Hydraulics and Aquifer Tests

« Site characterization is a priority work in most groundwater issued
field sites no matter what it is related to groundwater development or
remediation of contaminated groundwater

« Site characterization is the first and final step to study hydrogeological
processes in a groundwater developing area or a contaminated area.

« Various types of investigation technologies are employed to
characterize groundwater issued sites.

«  Well-performed investigation can give reasonable and proper
solutions.
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« Aquifer tests are principal part for site characterization
activities in many projects and studies dealing with groundwater
exploitation, protection and remediation

« Pumping tests and slug tests are typical aquifer tests including
packer test, tracer test

* To measure or estimate hydraulic parameters
(hydraulic conductivity, storativity and dispersion coefficient)

4 Hydraulic Head Analysis: flow direction
# Sieve Analysis : analysis on statistical distribution of grain size

& Permeameter Test : lab column test to measure the hydraulic
conductivity (soil and/or cored rock)

4 Pumping Test : interaction between pumping and observation well
# Slug Test : single well response
+ Step-drawdown Test : to determine well efficiency

# Packer Test (in crystalline rock) : to measure hydraulic properties
within the fixed range of well in crystalline rock

¢ Tracer Test
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33.5 Groundwater flow occur

* toward down-gradient

direction
325

e perpendicular to equipotential
32 TTine

¢ Definition of flow net:

A net combined with equipotential line and flow line in groundwater
system

Red lines
indicate
positions of
water table
contours when
from | well is pumping

http://wapt.isu.edu/envgeo/aquiter_gw, review/ilownets.htm
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» Const. Head Permeameter Test
— Moderate to high K
— K=VL/Ath

I

« Falling Head Permeameter Test
— Low K

~ K=[d2L/d2)]In(hy/h)]
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+  The principle of a pumping test involves
- applying a stress to an aquifer by extracting groundwater from a pumping well
- measuring the aquifer response to that stress by monitoring drawdown as a function of time.

These measurements are then incorporated into an appropriate well-flow equation to calculate
the hydraulic parameters of the aquifer.

It can be applied to single-well or multi-wells (observations)

10
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+ To obtain data with which to:

@ Assess the hydraulic behavior of a well and so determine its ability to yield water,
predict its performance under different pumping regimes, select the most suitable
pump for long-term use and give some estimate of probable pumping costs;

@ Determine the hydraulic properties of the aquifer or aquifers which yield water to
the well; these properties include the transmissivity and related hydraulic
conductivities, storage coefficient, and the presence, type and distance of any
hydraulic boundaries; and

(3 Determine the effects of pumping on neighbouring wells, watercourses or spring
discharges.

1"

Two parameters define the quantitative hydrogeological properties of an aquifer
@ Permeability
- the ability of an aquifer to permit groundwater flow under a hydraulic gradient
@ Storage

- the volume of water available within the aquifer and subsequently released when water levels
are depressed around a discharging well.

With a low permeability and a large storage coefficient
- slow increase of the radius of influence(ROI)

With a high permeability and a small storage coefficient
- rapid increase in the growth of the radius of influence.

12
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13

14
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+  There are several things should be considered before starting pumping test

@ Literature review for any previous reports, tests and documents that may include data or
information regarding geologic and hydrogeologic systems or any conducted test for the
proposed side.

@ Pumping tests should be carried out within the range of proposed or designed rate. For new
wells, proper pumping rate can be decided based on the results of step drawdown test.

® Avoid influences such as the pumping of nearby wells and the pumping well itself shortly
before the test

@ Determine the nearby wells that will be used during the test if it is likely they will be affected,
this well depends on Radius of Influence(Ro).

® *Ro=SQRT(225x Tx t/S) for confined aquifer

15

+  There are several things should be considered before starting pumping test

® Pumping tests should be carried out with open-end discharge pipe in order to avoid back
flow phenomena.

@ Make sure water discharge during the test does not interfere with shallow aquifer test

Measure groundwater levels in both the pumping test well and nearby wells before at least
24 hours of start pumping to check a natural trend.

© Determine the reference point of water level measurement in the well
Determine number, location and depth of observation wells (if any)

16
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*  Pumping well and one or more observation wells

* Equipment preparation
— (Submersible) pump, discharge pipe(hose) and check valve for pumping
— Flowmeter (or bucket) and stopwatch for measuring flow rate

— Electrical tape and/or ata logger for measuring drawdown
~ Data collection sheet

e

il

17

«  Water level measurements for pumping well could be taken as the following;
+  For Constant rate pumping test

Time since start of pumping (minutes) Time intervals (minutes)

0~5 0.5

5~ 60 5
60 ~ 120 20
120 ~ 720 60
720 ~1440 120

- For each step of step drawdown pumping test

0~10 1
10~ 20 2
20 ~ 60 5

18
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«  Water level measurements for observation well can be taken as the following:
*  For Constant rate pumping test

Time since start of pumping (minutes) Time intervals (minutes)

0~5 0.5
5~ 15 1
15 ~ 50 5
50 ~100 10
100 ~ 300 30
300 ~ 720 60
720 ~ 1440 120
1440 ~ end 480

19

+  After the pump has been shut down, the water levels in the well will start to rise
again. This rise can be measured in what is known as recovery test.

«  If the pumping rate was not constant throughout the test, recovery test data are
more reliable than drawdown data because the water table recovers at a constant
rate.

+  Measurement of recovery shall continue until the aquifer has recovered to within
95% of its pre-pumping static water level

Measurements of pumping rate

- During constant pumping rate, it could be changed as drawdown
increases. However, it must be kept constant throughout the test

- Measure at least once every hour

- Any necessary adjustments shall be made to keep it constant.

20
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« ltis difficult to determine the pumping duration because the pumping period
depends on the type and natural materials of the aquifer. In general pumping test
is going on until pseudo-steadly state flow is attained or dynamic water level
fluctuate slightly.

*  In some tests, steady state occurs a few hours after pumping, in others, they
never occur. However, 24-72 hours test duration is enough to produce diagnostic
data.

21

+ For a new well, through a equipment test for well development (surging), well
productivity can be preliminary estimated.

+  Through step drawdown test following recovery test, optimal pumping rate can
be determined for the long-term pumping test.

+  Constant rate pumping test can be carmied out at the pumping rate which
determined by step drawdown test

22
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When field data curves of drawdown versus time deviated from theoretical curves
of the main types of aquifer, the deviation is usually due to specific boundary

conditions such as partial penetration well, wellbore storage, recharge boundary,
or impermeable boundary.

Theoretical curve for confined aquifer

23

With partial penetration well, the condition of horizontal flow is not satisfied, at
least not in the vicinity of the well. Vertical flow components are inducing extra
head losses in the well.

-

- 146 -
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« If a pumping test is conducted in a large-diameter well, the data will be affected
by the wellbore storage in the pumped well. At early pumping time, data will
deviate from the theoretical curve.

*  Delayed drawdown compared to the theoretical curve
+ Disappears as pumping continues

25

*  Recharge or impermeable boundaries can also affect the theorectical curves of all
aquifer types.

« The field data curve then begins to deviate from the theoretical curve up to
stabilization in recharge case

N

26
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Effect of impermeable boundary

*  Impermeable boundaries have the opposite effect on the drawdown.
+  If the cone of depression reaches such a boundary, the drawdown will double.

=

27

+  Pumping test solution methods: to estimate aquifer properties
- Theis (confined)

- Cooper-Jacob (Time-drawdown) (confined)

- Hantush and Jacob (leaky-confined)

- Neuman (unconfined)

- Moench (unconfined/ partial penetrations well)

- Moench (fracture flow)

* Step test solution methods: to determine well performance and efficiency
- Theis (confined)

- Cooper-Jacob (confined)

- recovery test

28
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 Step drawdown test developed to assess the well performance
(well losses due to turbulent flow)

* Atlest 5 pumping steps are needed, each step lasting from 1 to 2
hours

» step drawdown test is used to determine the optimum pumping
rate

»  Step drawdown test can be used to determine T and S from each
step

31

* Total drawdown in a well (Jacob)
s;=s,+s,=BQ+CQ? (1)
where
s is the total drawdown,
s,(=BQ): part of drawdown due o aquifer losses (as laminar term)
$,(=CQ) : drawdown due towelllosses (a1
Q: Pumping rate
sQ=B+CQ (2)

Lp=BQ/(BQ+cx100 (3)
-> \Well efficiency

32
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 Well efiiciency is the ratio between theoretical drawdown and the
actual drawdown measured in the well

+ Awell efficiency of 70% or more is usually acceptable

* Ifa newly developed well has less than 65% well efficiency, it
should not be accepted. It need a well development process such
as surging.

33

Optimum pumping rate
- Determining the optimum pumping rate is based on the well loss and well efficiency

1. for up to ten different Q, find s; based on the equation s; = BQ + CQ?

2. for the same pumping rate, find theoretical drawdown(s) through the equation, s=
(Q/2nT)In(R/r,,)

3. calculate well efficiency for all pumping rates

4. demonstrate graph between efficiencies and pumping rates, and choose the Q
value that correspond more than 65% efficiency or more.
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35

+ Advantages of Slug Test
— Simpler and quicker than pumping test
— Useful for small scale study
— Goodinlow K layer

[]]

\ / potentiometric surface

- after slug injection

ES
| f——]
I||I
f
II|

A T
. potentiometric surface aquifer
betore slug injection K. KK,
H L b
v L]
7 2I‘\\ v
aquiclude
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Falling head slug test:
- place transducer sufficiently below to avoid interference with slug

- place slug just above top of water column
- drop slug
- record water level as it returns to static position

Rising head slug test:

- place slug just below water table

- withdraw slug as quick as possible
- monitor water level

37

* Slug test solution methods:
- Hvorslev

- Bouwer-Rice

- Hantush-Bierschenk

38
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* Hvorslev straight line method (confined aq.)

Plot of hho vs. time on semiHog plot

Draw straight line through data

Draw straight line through data at HH,=0.37

Calculate Kusing T,, 1, L, R

K= r*In(L/R)
2LTo

*  Bouwer-Rice method (unconfined aq.)

—  Similar with the procedure of Hvorslev method

*  Recommended nomalized head range for straight line match
— Hvorslev=0.15~0.25
— Bouwer-Rice =0.2~0.3

39

Pumping test reports should include the following;

v' A'map, showing the location of the investigated site, pumping and observation wells.
v" Detalils on the existed wells (main data).

v" Well logs and construction details for all wells.

v' Geological cross--section of the study area.
v

Tables of field measurements: Drawdown measurements, time of measurement and

flow rate (including soft copy)

v The calculations in an abbreviated form, including the values obtained for the aquifer

parameters and discussion of their accuracy.
v" Recommendations.

v' Summary.

40
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* Analytical Software
— AQIESOLV or Aquifer Test ...

— Exercise in the next module

41

Thank you very much
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Analysis of Aquifer Test (Exercises)

+  Software for the analysis of aquifer tests (pumping tests, constant-head tests and slug tests)
*  Glenn M. Duffield, HydroSOLVE, Inc, USA

Features in AQTESOLV
- Solution for Unconfined Aqifer with 3D Saturated/Unsaturated Fow
- ConstantHead Tests
- Solutions for Nonuniform Aquifers
- Generalized Radlial Fow Model
- Solution for a Water-Table Aquitard!
- Underdamped Slug Tests with Partially Penetrating Wels
- Horizontal Wells
- Single-Fracture Solutions
- Step-Drawdown Test in Leaky Aquifer
- Confined Two-Aqifer System
- Automatic Image Wel Generation
- Delayed Observation Wel Response
—  Dagarks Slug Test Method for Wells Saeened Aaoss Water Table
- Sug Tests in Fractured Aquifers
- Distance-Drawdown Analysis
- Groundwater Mounding
—  Diagnostic Flow Plots
- Adive Type Cunves




UNESCO i-WSSM

Pumping Obs. Well
Well (16-1) (R6-2)

Well depth (ft) 105 105
Water level depth (ft bgl*) 5 5
Screen Length (ft) 20 3
Well diameter (ft) 1 1/6
Pumping rate (ft3/d) 108,760

Distance from pumping well (ft) 154
Aquifer thickness (ft) 21

* bgl = below ground level

*  Open AQTESOLVexe
*  File — New — Choose "Pumping test wizard" for data set type
+  Choose "Multiwell test” for test type
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« Default
«  Pumping test
— Data set for a single- or multi-well test
« Constant-head test
* Slug test

« Forward solution
— Predictive simulation of a pumping test

* Import AQTESOLV for DOS
— Import data set created with a DOS ver. Of AQTESOLV

+  Pumping Test Wizard—Step 1 (Unit-ft, min, ft3/day; ft/day)
+  Pumping Test Wizard—Step 2 (Project Information)

< Unit > < Project Info >




UNESCO i-WSSM

* Pumping Test Wizard—step 3 (Aquifer Data)
—  Thickness: 100 ft, Kv/kh: 0.1

< Aquifer data >

*  Pumping Test Wizard—step 4 (PW Data)
— Name: 16-1, (xy): Q0)

< well Location>
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+  Pumping Test Wizard—step 5 (PW Construction)
—  Select "vertical, partial penetration(2)" for well configuration
— d: 80t L 20 ft Unit pumped aquifer

< PW Construction >

9

*  Pumping Test Wizard—step 6 (PW Radius)
— rQ=r(w) 05 ft rfeq):Oft
*  Pumping Test Wizard—step 7 (PW Rate Data)
- Insert Row or Add Rows of 1
— Type'0" -> enter -> type "108760" -> enter
— Type"600" -> enter -> type “108760" -> finalize by dicking mouse

< PW Radius > < PW Rate data >

10
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*  Pumping Test Wizard—step 8 (OW Data)
— Name: R6-2 (xy): (1540)

+  Pumping Test Wizard—step 9 (OW Construction)
—  Select “vertical, partial penetration(2)" for well configuration
- d:97 1t L 3 ft, Unit pumped aquifer

< Obs. Well Location > < Obs. Well Construction >

1"

*  Pumping Test Wizard—step 10 (OW Radius)
—  rQ=rw): 0.1667 ft, r(eq): 0 ft

< Obs. Well Radius >

< Input data>

12
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% Input method 1: Add Rows and then type the data

N —
C—

< Observation data >

13

% Input method 2: Import file (.txt, .csv, .dat, .lev, .mon...)
= Step 1 of 3: Click “import file" -> Click "Browse” -> Select and open the
file "Exer2-4" -> Click "View import file"
»  Step 2 of 3: Columns= 2, starting row=2 -> check the box of "Elapsed time"
and select 1" -> Check the box of “displacement” and select "2"
= Step 3 of 3: Skip this step -> The imported data are shown on the window

"

14
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No errors detected in data set!!!

(I

B aqoe [o)f@=]
[The Error Log identifies errors detected in your data set. =
Choose this view when you see the "Check Errors” indicator on the status bar. A

No errors detected in data set |

ITips for Analyzing Aquifer Tests with AQTESOLY for Windows
Enter Test Data
Choose options from the Edit menu to enter or modify test data.
2. Perform Diagnostic Analyses (Optional)
Choose diagnostic flow plot and derivative plot options from the View menu.
3. Perform Curve Matching or Prediction
Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.
4. Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.
5. Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary

Pumping Test

No. of pumping wells: 1

No. of pumping periods (I8-1): 2

No. of observation wells: 1

Total no. of observations: 18

Range of time readings in obs. well(s). 11to 600 min

Range of displacement readings in obs. well(s): 2.21 to 6.47 ft

R/

% Error log

% Select "Displacement-time"” at
drop-down menu
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% Click "Match” on menu and “Solution”

—

S

O

1. uncheck the box “solution is
inactive”

2. Choose Aquifer type
- "unconfined” for example
3. Choose solution
17 - "Theis" for example

« Solutions for Pumping Tests
® Confined Aquifer

Moench-Prickett (1972) : confined aquifer undergoing conversion to water-table conditions.
—  Butler (1988) : nonuniform aquifer.
- Dougherty-Babu (1984) : confined aquifer with partially penetrating wells, wellbore storage and wellbore skin.
- Hantush (1962) : confined wedge-shaped aquifer.
—  Murdoch (1994) : confined aquifer with an interceptor trench.
—  Daviau et al. (1985) : confined aquifer with a uniform-flux or infinite-conductivity horizontal well.

—  Barker (1988) generalized radial flow solution for a pumping test in a single-porosity confined aquifer with wellbore
skin and nonintegral flow dimension.

® Leaky confined Aquifer
—  Cooley-Case (1973) : leaky confined aquifer overlain by a water-table aquitard.
—  Neuman-Witherspoon (1969) : leaky confined two-aquifer system.

® Unconfined Aquifer
—  Tartakovsky-Neuman (2007) : unconfined aquifer with 3D flow in the saturated and unsaturated zones.

® Fractured Aquifer
—  Gringarten-Witherspoon (1972) : fractured aquifer with a uniform-flux vertical fracture.
—  Gringarten-Ramey-Raghavan (1974) : fractured aquifer with an infinite-conductivity vertical fracture.
—  Gringarten-Ramey (1974) : fractured aquifer with a horizontal fracture.
—  Barker (1988) generalized radial flow solution for a pumping test in a double-porosity fractured aquifer with slab
shaped or spherical blocks, fracture skin, wellbore storage, wellbore skin and nonintegral flow dimension.

18
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« Solutions for Slug Tests
® Confined Aquifer

— Dougherty-Babu (1984) : confined aquifer with partially penetrating wells and wellbore skin.

— Butler (1998) : confined aquifer with partially penetrating well and underdamped (oscillatory)
response.

— Butler-Zhan (2004) : confined aquifer with partially penetrating wells and underdamped (oscillatory)
response.

® Unconfined Aquifer

- Springer-Gelhar (1991) : unconfined aquifer with partially penetrating well and underdamped
(oscillatory) response.
— Dagan (1978) : unconfined aquifer with a well screened across the water table.

® Fractured Aquifer
- Barker-Black (1985) : double-porosity fractured aquifer with slab-shaped blocks.

19

+ Solutions for Constant-Head Tests

® Confined Aquifer
— Jacob-Lohman (1952) : confined aquifer.
- Hurst-Clark-Brauer (1969) : confined aquifer with wellbore skin.
— Dougherty-Babu (1984) : confined aquifer with partially penetrating wells and wellbore skin.
- Barker (1988) : single-porosity confined aquifer with wellbore skin and nonintegral flow dimension.

® |eaky Aquifer
- Hantush (1959) : leaky aquifer.
—  Moench (1985) : leaky aquifer with wellbore skin and storage in the aquitard(s).

® Fractured Aquifer
- Barker (1988) generalized radial flow solution for a constant-head test in a double-porosity fractured
aquifer with slab shaped or spherical blocks, fracture skin, wellbore skin and nonintegral flow
dimension.
— Ozkan-Raghavan (1991) : fractured aquifer with a uniform-flux or infinite-conductivity vertical
fracture

20
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% Click “Match” on menu % Click “Estimate” on the
and select “"Automatic” » pop-up window

% Click “Confirm” if the
solution is converged

21

«» Parameter Estimation Results Og;;“;”s

Aguifer Model
Unconfined

Solution
Theis

Parameters
T =128E+4 ft2iday
S =8205E5
Kz/Kr = 0.1
b =100t

% Unconfined aquifer — Theis

solution
% K(=T/b) = 128.0 ft/day
% S = 8.205x10°

22
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% Choose "Visual” from the “Match” menu.

% Drag the left mouse button on the graph to match the type
curve with data

% Release the left mouse button when you have finished matching
the type curve.

23

7
%

“View" on menu - select “format”
% “View” on menu - select “Options”

—

24
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% "File” on menu — Select “Export”
% X-Y plot data, well data, Type curve, Graph figure file

2 Exercise 4-2
10

D

Corrected Displacement (ft)

Time (min)

25

- Single-well test in a confined aquifer

- with wellbore storage and wellbore skin




UNESCO i-WSSM

* Initial source of pumped water from a storage in the well casing
*  Delayed drawdown compared to predicted response
+ Disappear as pumping continues

% diagnosis - radial flow plot

* Wellbore storage €—-—> Aquifer storage = On rad.ial (log-log) pl(_)t,
i early-time data showing a
-5 unit slope

» A characteristic peak in the
derivative curve near the
end of the wellbore storage

Gerivatiyg

. period _
Peak near the end of wellbore storage period

Unit slope at early time.

logt » 27

*  Results from a zone of altered permeability near the wellbore
—  Positive skin : lower permeability in a damaged skin zone
+ Mud infitration, screen bridging by coarse particles, mineral ppt, improper screen size(smaller than
sorounding pores)

* rwe < I'-W
c bore-hole ;I
. . ] .
» Negative skin : Enhanced —_—_ oo Clgdlegerlenl
.- " 1
permeability e : aquifer loss
. . A3 heoretical drawdown f drawd
= Hydraulic fracturing, well 4 v compenent o drandown
development, natural : ek zone,
. . w» K0 residual mud ! linear well loss
fracture or solution opening W= - = = = ¥ head foss in gravel pack | compenent of drawdown
A = =~ T T screen entrance head loss
" olye > Ty zone affected by ‘\ 3 ‘._ ==\ head loss due to j?on-linearwell loss

drilling mud turbulent flow

component of drawdown

® My =1, €W
= r,: norminal well radius
» r,.: effective well radius
» s, : wellbore skin factor
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Negative skin

Positive skin

|
|
|
|
| r
|
|
|

Theoretical drawdown

29

nonleaky confined aquifer, Lynden, WA

% In this example, you will analyze
data from a single-well pumping test
conducted in a 500-ft deep confined
aquifer near Lynden, Washington.
The six-inch diameter test well was

The well is screened over the lower
10 feet of the sand and gravel
comprising the 40-ft thick aquifer.
Pumping continued for more than
two weeks at a constant rate of 50
gpm. Time and drawdown
measurements were recorded in
minutes and feet, respectively.

constructed in an eight-inch borehole.

+  Constantrate test in pumped well (single-well test) with wellbore storage and skin in a

P 50 gpm

“»
v

500 ft

Aquiclude

wft . Aquifer
10ﬂI H :

Aquiclude

30
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1. Create a new data set by choosing New from the File menu.
In the New Data Set dialog, select Pumping Test Wizard from the list. Click OK.
Choose Single-well test for the type of pumping test. Click OK.

oW

The Pumping Test Wizard prompts you for data required to analyze a single-well pumping

test. Click Next to begin the wizard.

5. For units of measurement, choose ft for length, min for time, gal/min for pumping rate and
ft/day for hydraulic conductivity. Click Next.

6. For project information, enter Lynden, WA for the location. Click Next.

7. For aquifer data, assume 40 for the aquifer thickness. Enter 1 for the anisotropy ratio (i.e,,
assume hydraulic conductivity is isotropic). Click Next.

8. For pumping well data, enter PW-3 for the well name. Enter coordinates of X=0 and Y=0.

Click Next.

9. For pumping well construction, select the option for vertical, partial penetration. Enter 30

for depth to top of screen and 10 for screen length. Click Next.
31

10. For pumping well radius data, enter 0.333 for casing radius and 0.25 for well radius. Click
Next

11. For pumping rates, enter 0 for time and 50 for rate in the first row of the spreadsheet. Click

Next.

12. For observations, click Import to launch the Observation Data Import Wizard for importing
data from a file.

a. In Step 1 of the wizard, click Browse. Select the import file PW-3.txt in the AQTESOLV installation
folder and click Open. Click Next.

b. In Step 2 of the wizard, accept the default entries and click Next.
¢. In Step 3 of the wizard, click Finish. Inspect the import file summary and click OK.
d. Click Next to proceed with the Pumping Test Wizard.
13. You have completed the Pumping Test Wizard. Click Finish.
14. Any Errors or warning? Save the data set by choosing Save as from the file menu. Enter

PW-3 for the name of the file and click Save.

32
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It is ok because it is a confined aquifer!

In case of an unconfined aquifer, change the aquifer saturated
thickness or check the unit of the displacement
1.Choose aquifer data from the edit menu to change the aquifer property
2.Choose units from the edit menu to change units

33

+  Before performing curve matching to estimate aquifer properties, you
may use diagnostic features in AQTESOLYV to evaluate aquifer and
flow conditions.

® Choose Radial Flow from the View menu to display a radial flow plot
on log-linear axes.

Late-time data plotting as a straight line indicate radial flow
conditions in an infinite-acting aquifer.

® (Choose Log Axes from the View menu to display the radial flow
plot on log-log axes.

® Choose Visual from the Match menu. Click the mouse over the
second data point on the plot to display a line with unit slope over
the early-time data.

Early-time data with unit slope on a radial flow plot with log-
log axes is characteristic of wellbore storage.

34




UNESCO i-WSSM

« Derivative analysis is another useful diagnostic tool for evaluating aquifer
conditions.

® Choose Displacement-Time from the View menu to display a plot of the test data.
Choose Log Axes from the View menu to display the data on log-log axes.
® Choose Wells from the Edit menu. Select PW-3 from the list and click Modify.

® In the Symbols tab, remove the check from Use data symbols properties and select cross for the
derivative symbol.

® In the Curves tab, remove the check from Use type curve properties. Click Color for the derivative
curve properties, change the color to red, and click OK.

® C(lick OK and then Close.

® Select Options from the View menu. In the Plots tab, check
Derivative curves. In the Derivative tab, select the option for
Bourdet and enter a differentiation interval of 0.4. Click OK.

The peak on the derivative plot is characteristic of wellbore
storage. At intermediate to late time, the derivative
approaches a constant value when the aquifer is infinite
acting.

35

«  From the radial flow and derivative plots, we have know that test was performed in confined
aquifer with wellbore storage

«  Preliminary estimates of T using Cooper-Jacob (1946) solution

1. Choose Solution from the Match menu to select a method for analyzing the data.

2. Remove the check from Solution is inactive. Click the + next to Confined Aquifers to expand
the list of available solutions for confined aquifers. Select Cooper-Jacob (1946) and click OK.
Choose Displacement-Time from the View menu.

4. Choose Visual from the Match menu to perform
visual curve matching with the Cooper-Jacob solution.

Match the line to late-time data after the wellbore
storage effect has dissipated.

5. Repeat the previous step as needed to achieve a
satisfactory match to the late-time data. Your
estimate of T should be on the order of 250 ft2/day.

The low value of S that you obtain with the Cooper-Jacob
solution is an indication of partial penetration effect and
possibly wellbore skin effect at the pumped well.

36
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1. Choose Solution from the Match menu to select a method for analyzing the data.

2. From the list of solutions for Confined Aquifers, select Dougherty-Babu (1984)
and click OK.

3. Choose Log-Linear Axes from the View menu to view the data on log-linear axes.

4. Choose Toolbox from the Match menu. In the
Tweak tab, select S from the list of parameters.
Use the scroll bar to adjust the value of
storativity to match the late-time data. You can
set the range of storativity values by editing
the minimum and maximum values for S in the
Parameters tab.

The Dougherty-Babu solution accounts for partial
penetration; however, the implausibly low value of S
determined from this analysis indicates wellbore skin
effect.

37

1. In the Parameters tab, enter 0.0002 for S as a plausible estimate of storativity in a
confined aquifer. In the Tweak tab, select Sw (wellbore skin factor) from the list of
parameters. Use the scroll bar to adjust the value of wellbore skin factor to match
the late-time data. You can set the range of wellbore skin factor values by editing
the minimum and maximum values for Sw in the Parameters tab.

It is not possible to estimate S and Sw
simultaneously from a single-well test. If an
estimate of S is available independently from
an observation well, we may use it as a
known value in the analysis of pumping well
data; otherwise, we may assume a value of S
based on local hydrogeologic conditions.

Partial penetration and wellbore skin can
produce virtually identical effects in a
pumping well's drawdown response. In this
case, decreasing the penetration ratio, L/b,
was equivalent to increasing the wellbore
skin factor.

38
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1. In the Tweak tab, select r(c) from the list of parameters. Use the scroll bar to adjust
the value of casing radius to match the early-time data. You can limit the range of
casing radius values by editing the minimum and maximum values for r(c) in the
Parameters tab. After you have aligned the curve with the early-time data, click OK.

Adjust the casing radius value to match
early-time data affected by wellbore
storage. In many cases, the effective
casing radius turns out to be less than
the nominal value because of equipment
in the well such as discharge tubing and
transducer cable.

T = 250 ft2/day

Final S = 0.0002
Estimate of Kz/Kr = 1.0
Parameters Sw =12

r(w) = 0.333 ft
r(c) = 0.165 ft

Choose Save from the File menu to

save your work.
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*  Use the Cooper-Jacho (1946) solution to obtain preliminary estimates
*  Examines the data using Diagnostic flow plots

Summary of Drawdown Characteristics for Selected Flow Regimes

Regime

Diagnostic Flow Plot

Characteristic

Wellbore storage

radial flow plot (log axes)

unit (1:1) slope at early time

Infinite-acting radial flow

radial flow plot (semilog axes)

constant positive slope at late time

Infinite-conductivity fracture

linear flow plot (log axes)

unit (1:1) slope at early time

Finite-conductivity fracture

bilinear flow plot (log axes)

unit (1:1) slope at early time

No-flow boundary

radial flow plot (semilog axes)

slope doubles

Channel (strip) aquifer

linear flow plot (log axes)

unit (1:1) slope at late time

Closed aquifer

radial flow plot (log axes)

unit (1:1) slope at late time

Constant-head boundary

radial flow plot

zero slope at late time

Spherical flow

spherical flow plot (log axes)

negative unit (-1:1) slope

Early

« wellbore storage
* linear flow (fracture)
* bilinear flow (fracture)

Occurrence of Flow Regimes

Intermediate

« infinite-acting aquifer
« spherical flow
* Inter-porosity flow

40

Late (Boundaries)

* no-flow

* recharge

» channel aquifer
« closed aquifer
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Perform visual curve matching prior to automatic estimation to obtain reasonable
starting values for the aquifer properties.

+ Use parameter tweaking to perform visual curve matching and sensitivity analysis for partial
penetration effect, wellbore skin effect and wellbore storage effect

41

Thank you very much







